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Presentation Objectives

• To discuss decisions that must be made 
before using QuickBooks

• To create a new QuickBooks company 
using the EasyStep Interview
To set QuickBooks preferences in the• To set QuickBooks preferences in the 
Interview

• To record the opening balance for a 
checking account

• To enter customers, jobs, vendors, 
accounts, and items
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Presentation Objectives

• To gain an overview of the QuickBooks 
program

• To know how QuickBooks works and 
how to get around in QuickBooksg Q

• To learn common business terms used 
by QuickBooks

• To review the QuickBooks Help tools
• To see how to exit QuickBooks properly
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Who uses QuickBooks?

• The QuickBooks Financial Software 
family consists of a range of products to 
meet the needs of a variety of small 
businesses. 
Alth h Q i kB k k f• Although QuickBooks works for 
companies of various sizes and across 
many industries, there are a few 
situations in which QuickBooks may not 
be the best solution for a client. 
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Who uses QuickBooks?
• If the business generates more transactions than 

QuickBooks can handle, performance may be 
affected. Technically, QuickBooks Pro and Premier 
can handle two billion transactions in a single 
company file. In practice, however, tasks like 
running reports and finding transactions can takerunning reports and finding transactions can take 
longer if the file grows too large. Clients who 
outgrow Pro or Premier consider upgrading to 
Enterprise Solutions.

• Companies that require more users simultaneously 
accessing the company data file than QuickBooks 
supports may not be suited for QuickBooks.
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Who uses QuickBooks?

• QuickBooks Pro and Premier 
support up to five simultaneous 
users; Enterprise Solutions is 
scalable up to 30 peoplescalable up to 30 people 
accessing the file at the same 
time; and QuickBooks Online 
supports up to 25 simultaneous 
users.
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Who uses QuickBooks?
• Companies that require an inventory method 

other than average cost (such as FIFO or LIFO) 
may want to use QuickBooks with an add-on 
software for the inventory feature. An exception is 
QuickBooks Online Plus offers Inventory using 
the FIFO cost method. 

• Companies with list requirements that exceed• Companies with list requirements that exceed 
those in the QuickBooks might not be a good fit. 
The limits are “in combination” with each other. 
As example – in Premier, you can have 14,500 
customers, vendors and items COMBINED. It is 
still a big number, but customers need to be 
aware that because of list limitations overall, 
Enterprise is sometimes the best choice. 

Carmen F. Calabrese PH.D.

Creating a QuickBooks Company
EasyStep Interview involves setting up a  business:
• Company Information
• Your industry
• Your company organization
• Sales information
• Sales tax information

Estimates• Estimates
• Sales orders
• Sales receipts
• Preferences
• Business start date
• Creating an account and entering an opening balance
• Reviewing the chart of accounts based on your industry 
• Completing company file setup
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Starting the EasyStep Interview

To begin adding a new company:
1. Start QuickBooks.
2. Select Create a new company, click the 

Start your new company file now 
button, or choose New Company from 
the File menu. QuickBooks displays the 
EasyStep Interview window.

3.“”””OPEN SAMPLE FILE””””
4. Give handout
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New File Creation
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Entering Company Info

To create a new QuickBooks company file:
1. At the Welcome window for the interview, 

click Start Interview to begin.
2. In the Company Name field, type company 

name and press Tabname and press Tab.
3. Press Tab again and type the Tax ID 

number. 
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Entering Company Info

4 Type the following 
information in the address, 
city, state, and ZIP fields:

5 Enter the following5 Enter the following 
information in the Phone # 
and Fax # fields:

6 Next enter the email and Web 
addresses
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Entering Company Info

8. In the “Select your industry” window, scroll 
down the list until you find the industry of 
which you are part, then select it.

9. In the “How is your company organized?” 
window, select Sole Proprietorship, LLC, S 
or C corp.

10. In the “Select the first month of your fiscal 
year” window, make sure January is 
selected.
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Entering Company Info

11.In the “Set up administrator 
password” window, click Next.

12.Click Next to save the company file.
13.In the “Filename for New Company” 

window make sure that QuickBookswindow, make sure that QuickBooks 
is set to save the file in the QB folder 
you set up during the introduction to 
the guide.

14.Click Save to accept the company’s 
name.
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Indicating what you sell

1.Click Next to display the 
“What do you sell?” window.

2.Select Both services and 
productsproducts.

3.Click Next.
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Entering sales information

To indicate how you enter sales:
1. In the “How will you enter your sales 

in QuickBooks?” window, click 
Record each sale individually.

2. Click Next.
3. In the “Do you sell products online?” 

window, indicate what you do.
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Entering sales tax information

To set up QuickBooks to track sales tax:
1. Click Next to move to the “Do you 

charge sales tax?” window.
2. Click Yes for the question, “Do you 

charge sales tax?” Then click Next.
QuickBooks automatically creates a 
current liability account, called Sales 
Tax Payable, that keeps track of the 
sales tax you collect in your business.
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Creating estimates

To create estimates for your 
business:

1. In the “Do you want to create 
estimates in QuickBooks?”estimates in QuickBooks?  
window, click Yes.

2. Click Next.
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Using sales orders and sales receipts

To set up sales orders and receipts:
1. Click Yes, if the “Tracking customer 

orders in QuickBooks” window 
displays, then click Next.
This screen appears if you are using 
QuickBooks Premier Edition or higher.

2. In the “Using sales receipts in 
QuickBooks” window, click yes or no.

3. Click Next.
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Choose remaining preferences

For this item: Select:

Billing statements No

Progress invoicing Yes

Bill tracking Yes

Do you print checks? I print checksDo you print checks? I print checks

Inventory No

Credit and debit cards I accept credit cards and 
debit cards

Track time Yes

Employees No

Track multiple currencies No
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2/21/2011

8

Choosing a start date

The start date is the date for which you give 
QuickBooks a financial snapshot of your 
company assets and liabilities.

To choose a start date:
1. In the “Using Accounts in QuickBooks” 

i d li k N twindow, click Next.
2. In the “Select a date to start tracking your 

finances” window, select Use today’s date 
or the first day of the quarter or month.

3. In the date field, type 12/31/2010 and then 
click Next.
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Entering opening balances

To enter the checking account opening 
balance:

1. On the “Add your bank account” 
window, make sure Yes is selected and 
then click Nextthen click Next.

2. Type Checking as the name of the 
account and click Next.

3. For “When did you open this bank 
account?,” click Before.

4. Click Next.

Carmen F. Calabrese PH.D.

Reviewing the chart of accounts

To review the chart of accounts:
1. In the “Review income and expense 

accounts” window, scroll through the 
recommended accounts to get an idea 
of what is includedof what is included.
You can remove or add accounts from 
this list. Clear the checkmark to remove 
an account; click in the checkmark 
column to add an account.

2. Click Next.
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Finishing the Interview
3. To leave the EasyStep Interview and save 

your changes, click Finish.
4. If the QuickBooks Learning Center appears, 

click Go to QuickBooks.
5. If the QuickBooks Coach appears, click Start 

Working.

After you have completed the EasyStep
Interview, Intuit recommends that you not use 
the Interview to make changes to your 
company file. 
Use the information in the help options 
described later to help you make changes and 
adjustments to your company file.
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Completing company file setup
After you have created your company file 
using the EasyStep Interview, you can begin 
using QuickBooks to run your business. 
However, there are some additional tasks you 
might need to do to make sure the company 
file is properly set up and that the data is 

l tcomplete.
QuickBooks is based on four key concepts:
• Customers & jobs
• Vendors
• Accounts
• Items

Carmen F. Calabrese PH.D.

QuickBooks Home Page
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Getting Around in QuickBooks
• Making the Home page your starting point

– The Home page provides a graphical 
representation of the workflow, organized in 
logical groups.

• Using the QuickBooks Coach
– The QuickBooks Coach guides you throughThe QuickBooks Coach guides you through 

business workflows.
• Getting an overview of your company

– The Company Snapshot gives you real-time 
information about how your company is doing 
and provides a location where you can keep 
track of the tasks you need to perform.
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Getting Around in QuickBooks
• Manage your open windows

– QuickBooks displays one window at a time.
• Using the menu bar

– You can find all commands on the menu bar.
• Using the icon bar

Th i b ll t– The icon bar allows you to manage your 
business more quickly and  provides quick 
access to the Centers.

• Using Centers
– The Customers, Vendors, Employees, and 

Reports centers give you quick access to 
common tasks.

Carmen F. Calabrese PH.D.

Adding customers

In order to bill customers with QuickBooks, 
you need to add your customers.

To add a customer:
1. Click Customer Center in the icon bar.
2. Click the New Customer & Job menu button, 

and then choose New Customer.
3. In the Customer Name field, enter the name 

of the customer as you would like it to 
appear on your Customers & Jobs list. 

Carmen F. Calabrese PH.D.
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Adding customers
4. Press Tab in the Opening Balance field to 

leave this field blank.
For now, leave this field blank. Lockhart 
Design is planning to set up one or more jobs 
for this customer. QuickBooks will calculate 

d t k th ll b l f thiand track the overall balance for this 
customer from the balances you enter for the 
individual jobs.

5. In Address Info tab, click in the First Name 
field and type name.

6. Press tab and type M. as the middle initial 
and in the Last Name field.
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Adding customers
7. Press Tab to go to the Address field, and then press 

Enter
8. Type address and press Enter.
9. Type cty, state and zip code.
10. Click Copy to copy the address to the Ship To field. 

Click OK in the Add to Ship To Address Information 
window.

11. Click OK to add this customer.
The Customer Center appears, with the Customers & 
Jobs list along the left side.
The Customers & Jobs list is the same list as the 
Customer:Job list. It is called Customers & Jobs on the 
Customer Center, and it is called Customer:Job on 
forms. 
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Adding a job

You do not need to add jobs to the 
Customers & Jobs list if your company 
never does more than one job or 
project per customer. Jobs in 
Q i kB k ti l If ftQuickBooks are optional. If you often 
perform multiple jobs for the same 
customer, you can use jobs in 
QuickBooks to track the activity for 
each job separately.
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Adding vendors

1. Click Vendor Center in the icon bar.
2. Click New Vendor in the button bar.
3. In the Vendor Name field, enter the

In order to pay your bills with QuickBooks, you need 
to add your vendors. Nearly everyone you pay, other 
than employees, are vendors. To add a vendor:

3. In the Vendor Name field, enter the 
name of the vendor as you would 
like it to appear on your Vendor list, 
then press Tab.

4. One option is In the Opening 
Balance field, type the amount 
owed this vendor as of the start 
date. Press Tab.
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Adding vendors
5. In the As Of field, enter the date
6. In Address Info tab, click in the First Name field and 

type first name.
7. Press tab and type the middle initial and the Last 

Name field.
8 Press Tab to go to the Address field and enter8. Press Tab to go to the Address field, and enter 

address
9. Click in the “Print on Checks As” field.
10.Click OK to add this vendor.
11.If you see a message about a past or future 

transaction, click Yes.
12.Close the Vendor Center.
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Setting up additional accounts
During the EasyStep Interview, you added one 
checking account. 
There are two basic types of accounts: balance 
sheet accounts, such as savings or checking, and 
accounts used to group transactions for reporting 

h i d tpurposes, such as income and expense accounts.
Income and expense accounts track the sources of 
your income and the purpose of each expense. 
When you record transactions, you usually assign 
the amount of the transaction to one or more 
income or expense accounts.
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Setting up additional accounts

A complete list of your business’ 
accounts and their balances appear in 
the chart of accounts. You use a chart 
of accounts to track how much money 
your company has how much money ityour company has, how much money it 
owes, how much money is coming in, 
and how much is going out.
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Adding items
• In QuickBooks, an item is anything that your 

company buys, sells, or resells in the course of 
business, such as products, shipping and handling 
charges, discounts, and sales tax (if applicable). 
You can think of an item as something that shows 
up as a line on an invoice or other sales or 
purchase formpurchase form.

• QuickBooks provides several different types of 
items. Some—such as the service item or the 
inventory part item—help you record the services 
and products your business sells. Others—such as 
the subtotal item or discount item—are used to 
perform calculations on the amounts in a sale.
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Adding items

To add an item:
1. From the Lists menu, choose Item List.
2. Click the Item menu button, and 

choose New.
3 In the New Item window choose3. In the New Item window, choose 

Service from the Type drop-down list.
4. Click in the Item Name/Number field 

and type item.
5. In the Description field, type 

description
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Adding items

6. Click in the Rate field, and type value.
7. In the Tax Code field, choose Non-

Taxable Sales from the drop-down list.
8. In the Account field, choose Add New.
9 In the new Account screen enter9. In the new Account screen, enter 

Consulting as the income account, then 
click Save and Close.

10.Click OK to add the new item to the Item 
List.

11.Close the Item List.
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Entering historical transactions

1. All sales (sales receipts, invoices, or statement 
charges)
C f

If your QuickBooks start date is before today’s date, you 
need to enter past transactions so that you have 
complete financial records from the start date forward. It 
is important to enter historical transactions in this order:

2. Customer payments received for outstanding 
invoices after the start date

3. Bills received since the start date
4. Bills paid since the start date
5. Deposits made to any of the accounts since the 

start date
6. Any other checks written (other than bills) 

since the start date
Carmen F. Calabrese PH.D.

All the Accounting Needed to Know

• About the chart of accounts
– The chart of accounts is a complete list of 

your business’ accounts and their balances.
• When you keep books for a company, you 

want to track:
– Where your income comes from 
– Where you put it 
– What your expenses are for
– And what you use to pay them

• You track this flow of money through the 
chart of accounts
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All the Accounting Needed to Know

• Assets
– Includes what you have and what people 

owe you.
• Liabilities

– What your company owes to other people.
• Equity

– Equity is the difference between what you 
have and what you owe.

– Equity = Assets – Liabilities
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All the Accounting Needed to Know
Cash versus accrual bookkeeping
• Cash basis

– Income is recorded when money from sales 
is received and expenses when bills are paid.

• Accrual basis
– Income is recorded at the time of the sale– Income is recorded at the time of the sale 

and expenses when you receive the bill.
• When you create reports in QuickBooks, 

you can switch between cash and accrual 
reports at any time, regardless of which 
bookkeeping method you have chosen for 
tax purposes.
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All the Accounting Needed to Know
Top Three Reports to assess performance 
• The balance sheet

– A snapshot of company on one date. It shows:
• What you have (assets)
• What people owe you (accounts receivable)
• What your business owes (liabilities and accounts payable)
• The net worth of your business (equity)

• The profit and loss statement (income statement)
– A profit and loss statement or income statement shows 

income, expenses, and net profit or loss
• Statement of cash flows

– Shows receipts and payments during a specific accounting 
period
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All the Accounting Needed to Know

• General journal transactions
– Traditional accounting method
– Total amount in the Debit column equals 

the total amount in the Credit column
– Each amount is assigned to an account in 

the chart of accounts
– Must balance equation

ASSETS = LIABILITIES + EQUITY
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Getting help while using QuickBooks

• Onscreen Help to provide conceptual 
information and step-by-step 
instructions.

• Tutorials on key tasks. These are 
available by choosing Learning Centeravailable by choosing Learning Center 
Tutorials from the Help menu.

• Live Community. Instant access to 
frequently asked questions and experts 
who can answer your own questions.
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Getting help while using QuickBooks

To find a topic in onscreen Help:
1. From the Help menu, choose QuickBooks 

help, and then click the Search tab.
2. Type customers and click the arrow 

buttonbutton.
3. Click Edit or  change customer 

information.
QuickBooks displays the topic in the lower 
portion of the help window.

4. Show the help on home page (Critical)
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Exiting QuickBooks

• To exit QuickBooks
– From the File menu, choose Exit.

• To make a back copy of a data file
– From the File menu, choose Save 

Copy or Backup
– ALWAYS BACKUP ON AN 

EXTERNAL SOURCE
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Final Comment

QuickBooks and Accounting is an 
information system that measures, 
processes, and communicates information, 
primarily financial in nature, about an 
identifiable entity for the purpose of making y p p g
economic decisions. It is not an end in itself 
but is a tool to be used in providing 
information that is useful in making 
reasoned choices among alternative uses of 
scarce resources in the conduct of business 
and economic activities. 

Carmen F. Calabrese PH.D.


